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C H A P T E R 11

Configuring MWTM for Your Network

This chapter provides the following information about configuring MWTM to better suit your needs:

• Importing SNMP Community Names from CiscoWorks (Solaris Only), page 11-2

• Retaining Unknown Objects from the MWTM Database (Server Only), page 11-2

• Changing MWTM Client Preference Settings, page 11-2

• Changing MWTM System Poller Settings, page 11-24

• Changing the Message Display, page 11-27

• Enabling SNMP Traps (Server Only), page 11-27

• Limiting Traps by IP Address (Server Only), page 11-29

• Setting the DISPLAY Variable (Client Only), page 11-30

• Backing Up or Restoring MWTM Files (Server Only), page 11-31

• Removing MWTM Data from the MWTM Server, page 11-32

• Configuring a Backup MWTM Server (Server Only), page 11-33

• Configuring MWTM with IOS Server Load Balancing, page 11-34

• Configuring an MWTM Client Connection Timer, page 11-35

• Telnetting to a Router, page 11-36
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Importing SNMP Community Names from CiscoWorks (Solaris 
Only)

MWTM enables you to store all SNMP community names in a single database in CiscoWorks Resource 
Manager Essentials (RME), and to export those names for use by MWTM.

To export the database from CiscoWorks RME to MWTM, use the following procedure:

Step 1 Log into CiscoWorks and select Common Services > Device and Credentials > Device Management. 
Then click the Export button.

Step 2 In the Device Export window, choose the device from the Device Selector panel. Then choose the 
following settings:

File Name Field = mwtm

Format = CSV

Run Type = Immediate

Step 3 Click OK.

CiscoWorks creates the /opt/CSCOpx/objects/dmgt/mwtm file in the default directory.

Step 4 When you start the MWTM server, MWTM looks for this file. If the file exists, MWTM merges the file 
with its own community name database, the /opt/CSCOsgm/etc/communities.conf file.

For more information about SNMP, refer to “Configuring SNMP Support” in the Cisco IOS Release 12.2 
Configuration Fundamentals Configuration Guide, Part 3, System Management.

Retaining Unknown Objects from the MWTM Database (Server 
Only)

By default, MWTM deletes all Unknown objects from the MWTM database after 7 days. To change the 
length of time unknown objects stay in the MWTM database, use the mwtm unknownage command. 
See the “mwtm unknownage” section on page C-70 for more information.

This method requires you to be logged in as the root user or as a super user. See the “Becoming the Root 
User (Server Only)” section on page 3-3 and the “Specifying a Super User (Server Only)” section on 
page 10-19 for more information.

Changing MWTM Client Preference Settings
When a user changes some aspect of the MWTM client, such as the size of a window or the order of 
columns in a window, MWTM makes note of the user’s preferences on the MWTM client and server. 
MWTM saves the user’s preferences to the MWTM server when the MWTM client exits.
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Thereafter, whenever the user launches the MWTM client, MWTM searches for the user’s MWTM 
preferences. If MWTM finds the user’s preferences on the MWTM server, MWTM launches the MWTM 
client with those preferences. Otherwise, MWTM launches the MWTM client with the default MWTM 
preferences file.

In addition to the user preferences that are automatically saved, MWTM enables you to change many 
GUI, data, topology, and table settings that affect the way MWTM presents its information.

Note Anyone who uses this MWTM client can change its preference settings, and the changes affect all views 
running on this client.
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This section includes the following information:

• Displaying the Preferences Window, page 11-4

• Customizing the Color of Event Severities, page 11-17

• Customizing the Color of Chart Data Series, page 11-19

• Restoring Default Preference Settings, page 11-22

• Loading an Existing Preference Settings File, page 11-22

• Saving the Preference Settings File, page 11-23

Related Topics:

• Viewing the Topology of the Network, page 8-1

• Working with Events, page 5-1

• Working with Nodes, page 6-1

Displaying the Preferences Window
When you change overall MWTM preference settings, you must first display the Preferences window. 
The Preferences window enables you to change the way MWTM presents information.

To display the Preferences window, select Edit > Preferences from the MWTM Main Menu. MWTM 
displays the Preferences window.

The Preferences window is composed of the following sections:

• Preferences Menu, page 11-4

• General GUI Settings, page 11-5

• Topology Settings, page 11-9

• Event Settings, page 11-10

• Charts Settings, page 11-14

• Status Settings, page 11-15

Related Topics:

• Working with Views, page 4-1

Preferences Menu

The menu on the Preferences window provides the following options:
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General GUI Settings

The General GUI settings in the Preferences window enable you to change general display settings for 
MWTM, including which window to display first when starting MWTM, and whether to display values 
in bits or bytes.

To display the General GUI settings, select General GUI in the left pane of the Preferences window.

The General GUI settings contain the following sections:

• Startup/Exit Settings, page 11-6

• General Display Settings, page 11-7

• Node Name Settings, page 11-8

• Poller Settings, page 11-8

• Repaint Priority, page 11-9

Menu Command Description

File > Load 
System Default 
Prefs

Restores all preference settings to the original system default settings.

File > Load
(Ctrl-L)

Loads an already existing set of preferences. MWTM prompts you for the name 
of the preferences file you want to load:

• Select the name of the preferences file, or accept the default filename, then 
click OK to load the preferences file. 

• Click Cancel to close the prompt window without loading a preferences file.

File > Save
(Ctrl-S)

Saves the preference changes.

File > Save As Opens the Save File Dialog: Preferences File List, which enables you to save the 
preferences file with a new name, or overwrite an existing preferences file.

File > Close
(Ctrl-W)

Closes the Preferences window.

To close the Preferences window at any time, click File > Close. If you have 
changed any preferences, MWTM asks if you want to apply the changes before 
leaving the window:

• Click Yes to apply the changes and close the prompt window and the 
Preferences window.

• Click No to close the prompt window and the Preferences window without 
applying or saving any changes.

• Click Cancel to close the prompt window without applying any changes. 
The Preferences window remains open.

Help > Topics
(F1)

Displays the table of contents for the MWTM online help.

Help > Window
(Shift-F1)

Displays online help for the current window.

Help > About
(F3)

Displays build date, version, SSL support, and copyright information about the 
MWTM application.
11-5
Cisco Mobile Wireless Transport Manager User Guide 5.0

OL-7637-02



 

Chapter 11      Configuring MWTM for Your Network
  Changing MWTM Client Preference Settings
Startup/Exit Settings

Use the Startup/Exit Settings section of the General GUI settings to specify whether you want to display 
the Topology Window when you launch the MWTM client, and whether you want MWTM to prompt 
you for confirmation when you exit the MWTM client.
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The Startup/Exit Settings section contains the following fields:

General Display Settings

Use the General Display section of the General GUI settings to specify whether MWTM is to:

• Display node domain names.

• Show details in bits instead of bytes.

• Show receive and send utilizations as percentages.

• Show the point code mask in bits instead of dotted notation.

The General Display settings contain the following fields:

Field Description

MWTM: Topology 
Window

Checkbox used to indicate whether the Topology Window is to be 
displayed when MWTM is started. The default setting for this checkbox 
is cleared.

Confirm Exit Checkbox used to indicate whether MWTM is to prompt you for 
confirmation when you exit the MWTM client. The default setting for 
this checkbox is selected.

Confirm Deletions Checkbox used to indicate whether MWTM is to prompt you for 
confirmation when you delete an object. The default setting for this 
checkbox is selected.

Note If you select the Do not show this again checkbox in a Confirm 
Deletion dialog, and you later decide you want MWTM to begin 
displaying the Confirm Deletion dialog again, you must select 
the Confirm Deletions checkbox to do so.

Field Description

Show Node Domain Names Checkbox used to indicate whether MWTM is to show node 
domain names in its displays. The default setting for this 
checkbox is cleared (do not show node domain names).

Show Details in Bits Instead of 
Bytes

Checkbox used to indicate whether you want MWTM to display 
data and data rates in bits or bytes:

• If you want MWTM to display data in bits, and data rates in 
bits per second, select this checkbox. This is the default 
setting.

• If you want MWTM to display data in bytes, and data rates in 
bytes per second, clear this checkbox.

Show Utilization as Percentage Checkbox used to indicate whether you want MWTM to display 
receive and send utilization for linksets and links as a percentage 
or in Erlangs:

• If you want MWTM to display utilization as a percentage, 
select this checkbox. This is the default setting.

• If you want MWTM to display utilization in Erlangs, clear 
this checkbox.
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Node Name Settings

Use the Node Name section of the General GUI settings to specify how MWTM is to display node 
names.

The Node Name settings contain the following radio buttons:

Poller Settings

Use the Poller section of the General GUI settings to change MWTM poller and counter settings.

The Poller settings contain the following fields and radio buttons:

Radio Buttons Description

Show DNS or User-Defined 
Names

Radio button used to indicate whether MWTM is to identify nodes by 
their DNS or user-defined names. The default setting for this radio 
button is selected.

Show IP Addr in Name Field Radio button used to indicate whether MWTM is to identify nodes by 
their IP addresses. The default setting for this radio button is cleared.

Field or Radio Button Description

Fast Poller Default (secs) Default interval, in seconds, for the fast poller. The valid 
range is 15 seconds to 60 seconds. The default setting is 
15 settings.

The fast poller is used in the MWTM Real-Time Statistics: 
CPU Statistics Window

You can change the valid range and default setting in the 
System.properties file. For more information, see the 
“Changing MWTM System Poller Settings” section on 
page 11-24.

Slow Poller Default (secs) Default interval, in seconds, for the slow poller. The valid 
range is 60 seconds to 300 seconds. The default setting is 
15 settings.

The slow poller is used in all MWTM client windows 
except those listed above that use the fast poller.

You can change the valid range and default setting in the 
System.properties file. For more information, see the 
“Changing MWTM System Poller Settings” section on 
page 11-24.

Show Counters Since Reboot Radio button used to configure the MWTM client to clear 
all counters in MWTM Web pages whenever the ITP 
reboots. The default setting for this radio button is selected.
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Repaint Priority

Use the Repaint Priority section of the General GUI settings to balance the responsiveness versus 
efficiency of the MWTM client. This setting controls how quickly the MWTM client repaints its 
displays.

The Repaint Priority section contains the following sliding control:

Topology Settings

Use the Topology settings in the Preferences window to change default settings for the Topology 
Window.

To display the Topology settings, select Topology in the left pane of the Preferences window.

The Topology settings contain the following fields:

Show Counters Since Last Poll Radio button used to configure the MWTM client to clear 
all counters whenever an MWTM Web page is polled. The 
default setting for this radio button is cleared.

Show Counters Since User Reset Radio button used to configure the MWTM client to clear 
all MWTM counters whenever the user resets the counters 
on an MWTM Web page. The default setting for this radio 
button is cleared.

Field or Radio Button Description

Field Description

Repaint Priority Balances the MWTM client’s responsiveness versus efficiency. The valid 
range is 0 through 10, with 0 representing a high repaint priority (high 
responsiveness, low efficiency) and 10 representing a high communication 
priority (high efficiency, low responsiveness):

• Slide the selector toward High Repaint Priority if you want to 
maximize repainting (responsiveness) over communication 
(efficiency).

• Slide the selector toward High Comm. Priority if you want to 
maximize communication (efficiency) over repainting 
(responsiveness).

• The default setting is 2 (the third mark from the left).
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Event Settings

Use the Event settings in the Preferences window to change the default background color for each type 
of event, to specify whether to display acknowledged events, and to specify the types of event MWTM 
is to display in the Event tables, including the category and severity of event, whether the event is 
acknowledged, and other properties.

To display the Event settings, select Events in the left pane of the Preferences window.

The Event settings contain the following sections:

• Event Colors, page 11-11

• Categories, page 11-11

• Severities, page 11-13

• Other, page 11-14

Field Description

Spring Layout Spacing 
Factor (1-10)

Indicates how far apart nodes are to be spaced when MWTM draws the 
Spring Layout topology map. Valid values are 1 through 10, with 1 being 
closer together and 10 being farther apart. The default spacing factor is 
5.

Even if you apply preferences and close the Preferences window, the 
new spacing factor is not reflected in the topology map until you select 
Topology Tools > Layout > Spring, or click the Spring Layout button.

Show Mouse Overs Checkbox used to specify whether mouse over popups are enabled in 
topology maps. The default setting for this checkbox is selected.

Draw Connections When 
Dragging Node

Checkbox used to specify whether MWTM is to draw connection lines 
in the topology map as you move nodes:

• If you want MWTM to draw the associated connection lines 
dynamically as you move a node, select this checkbox.

• If you do not want MWTM to draw the associated connection lines 
until after you have finished moving a node, clear this checkbox. 
This is the default setting.

X Performance Enhancer 
(AntiAliasing Off)

Checkbox used to specify whether antialiasing is on in the topology 
map. Antialiasing, which is on by default, improves the appearance of 
the icons and connections in the map.

However, antialiasing can impact the performance of the MWTM client 
on a remote workstation (that is, a Solaris/Linux workstation using 
xhost, or a Windows workstation using an X-Window system emulator 
such as eXceed or Reflection X).

• If you want to turn on antialiasing in the topology map, clear this 
checkbox. This is the default setting.

• If you want to turn off antialiasing, select this checkbox.

Keep in mind that performance is always better if you access MWTM by 
installing the MWTM client on the remote workstation.
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Event Colors

The Event Colors section of the Event settings contains the following fields and buttons:

Event Time Format

The Event Time Format section of the Event settings contains the following buttons:

Event Date Format

The Event Date Format section of the Event settings contains the following fields and buttons:

Categories

Use the Categories section of the Event settings to specify which event categories you want to display 
in the Event Window.

The Categories section contains the following default fields and buttons:

Field Description

Informational Indicates the background color for Informational events. The default color is 
white.

Normal Indicates the background color for Normal events. The default color is light 
green.

Indeterminate Indicates the background color for Indeterminate events. The default color is 
cyan.

Warning Indicates the background color for Warning events. The default color is blue.

Critical Indicates the background color for Critical events. The default color is red.

Major Indicates the background color for Major events. The default color is orange.

Minor Indicates the background color for Minor events. The default color is yellow.

Button Description

12 hour format Select this radio button to configure event time stamps using 12 hour format 
(for example, 07:10:09).

24 hour format Select this radio button to configure event time stamps using 24 hour format 
(for example, 19:10:09).

Button Description

Month first Select this radio button to configure event date stamps with the month 
appearing first (for example, 8/16/05).

Day first Select this radio button to configure event date stamps with the day appearing 
first (for example, 16/8/05).
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Note These are the default categories; there might be additional categories, as defined by the MWTM system 
administrator. For information about custom categories, see the “Changing Event Categories” section on 
page 5-23.

Field or Button Description

Status Checkbox used to indicate whether Status events are to be displayed in the Event 
Window. The default setting for this checkbox is selected.

Trap Checkbox used to indicate whether Trap events are to be displayed in the Event 
Window. The default setting for this checkbox is selected.

Create Checkbox used to indicate whether Create events are to be displayed in the Event 
Window. The default setting for this checkbox is selected.

Delete Checkbox used to indicate whether Delete events are to be displayed in the Event 
Window. The default setting for this checkbox is selected.

Discover Checkbox used to indicate whether Discover events are to be displayed in the Event 
Window. The default setting for this checkbox is selected.

Edit Checkbox used to indicate whether Edit events are to be displayed in the Event 
Window. The default setting for this checkbox is selected.

Ignore Checkbox used to indicate whether Ignore events are to be displayed in the Event 
Window. The default setting for this checkbox is selected.

Login Checkbox used to indicate whether Login events are to be displayed in the Event 
Window. The default setting for this checkbox is selected.

LoginDisable Checkbox used to indicate whether LoginDisable events are to be displayed in the 
Event Window. The default setting for this checkbox is selected.

LoginFail Checkbox used to indicate whether LoginFail events are to be displayed in the 
Event Window. The default setting for this checkbox is selected.

Logout Checkbox used to indicate whether Logout events are to be displayed in the Event 
Window. The default setting for this checkbox is selected.

OverWrite Checkbox used to indicate whether OverWrite events are to be displayed in the 
Event Window. The default setting for this checkbox is selected.

Poll Checkbox used to indicate whether Poll events are to be displayed in the Event 
Window. The default setting for this checkbox is selected.

Purge Checkbox used to indicate whether Purge events are to be displayed in the Event 
Window. The default setting for this checkbox is selected.

Select All Selects all event category checkboxes.

Deselect All Clears all event category checkboxes.
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Severities

Use the Severities section of the Event settings to specify which event severities you want to display in 
the Event Window.

The Severities section contains the following default fields.

Note These are the default severities; there might be additional severities, as defined by the MWTM system 
administrator. For information about custom severities, see the “Changing Event Severities and Colors” 
section on page 5-24.

Field Description

Informational Checkbox used to indicate whether events of severity Informational are to be 
displayed in the Event Window. The default setting for this checkbox is selected.

Normal Checkbox used to indicate whether events of severity Normal are to be displayed in 
the Event Window. The default setting for this checkbox is selected.

Indeterminate Checkbox used to indicate whether events of severity Indeterminate are to be 
displayed in the Event Window. The default setting for this checkbox is selected.

Warning Checkbox used to indicate whether events of severity Warning are to be displayed in 
the Event Window. The default setting for this checkbox is selected.

Critical Checkbox used to indicate whether events of severity Critical are to be displayed in 
the Event Window. The default setting for this checkbox is selected.

Major Checkbox used to indicate whether events of severity Major are to be displayed in the 
Event Window. The default setting for this checkbox is selected.

Minor Checkbox used to indicate whether events of severity Minor are to be displayed in the 
Event Window. The default setting for this checkbox is selected.
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Other

Use the Other section of the Event settings to further define the event filter for the Event Window. These 
settings are applied to all event displays in the current view.

The Other section contains the following fields:

Charts Settings

Use the Charts settings in the Preferences window to change default settings for the elements in real-time 
data charts.

To display the Charts settings, select Charts in the left pane of the Preferences window.

The Charts settings contain the following fields and button:

Field Description

Acknowledged Checkbox used to indicate whether only acknowledged events are to be 
displayed in the Event Window. The default setting for this checkbox is 
cleared.

Unacknowledged Checkbox used to indicate whether only unacknowledged events are to be 
displayed in the Event Window. The default setting for this checkbox is 
selected.

Time Before Checkbox used to indicate whether only events logged by MWTM prior to a 
specified date and time are to be displayed in the Event Window. The default 
setting for this checkbox is cleared.

Time Before Field Specifies the date and time prior to which events logged by MWTM are to be 
displayed in the Event Window. This field is grayed-out unless the Time 
Before checkbox is selected.

Time After Checkbox used to indicate whether only events logged by MWTM after a 
specified date and time are to be displayed in the Event Window. The default 
setting for this checkbox is cleared.

Time After Field Specifies the date and time after which events logged by MWTM are to be 
displayed in the Event Window. This field is grayed-out unless the Time After 
checkbox is selected.

Message Contains Checkbox used to indicate whether only events that contain the specified 
message text are to be displayed in the Event Window. The default setting for 
this checkbox is cleared.

Match Case Checkbox used to indicate whether only events that match the case of the text 
in the Message Contains field are to be displayed in the Event Window. This 
field is grayed-out unless the Message Contains checkbox is selected. If the 
Message Contains checkbox is selected, the default setting for this checkbox 
is cleared.
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Status Settings

MWTM enables you to customize the order in which status settings are sorted, as well as the color of 
each status setting.

When you change the sort order or the color of a status setting, most MWTM client windows reflect the 
new sort order or color immediately. All other windows reflect the new sort order or color at the next 
poll.

When you change the color of a status, most MWTM client windows reflect the new color immediately. 
All other windows reflect the new color at the next poll.

Field or Button Description

Series Indicates the time series being defined. A time series is a set of data collected 
sequentially at a fixed interval of time.

The default values for series are:

• Series 0: Dot, Solid, Red

• Series 1: Box, Solid, Green

• Series 2: Triangle, Solid, Blue

• Series 3: Diamond, Solid, Black

• Series 4: Star, Solid, Pink

• Series 5: Cross, Solid, Orange

• Series 6: Circle, Solid, Gray

• Series 7: Square, Solid, Light Green

• Series 8: Vertical Line, Solid, Red

• Series 9: Horizontal Line, Solid, Green

• Series 10: Dot, Solid, Blue

• Series 11: Box, Solid, Black

• Series 12: Triangle, Solid, Pink

• Series 13: Diamond, Solid, Orange

• Series 14: Star, Solid, Gray

• Series 15: Cross, Solid, Light Green

• Series 16: Circle, Solid, Red

Symbol Style Drop-down list box used to define the symbol associated with a series. To change 
the symbol for a series, select a new value: Dot, Box, Triangle, Diamond, Star, 
Vertical Bar, Horizontal Line, Cross, or Circle.

Line Style Drop-down list box used to define the style of line that connects data points in the 
chart. To change the line style for a series, select a new value: Solid, Long Dash, 
Long-Short-Long (LSL) Dash, Short Dash, Dash Dot, or None.

Color Indicates the current color for the series.

Change Color Opens the Select Series Color dialog, which enables you to select a color for a 
series. For more details, see the “Customizing the Color of Chart Data Series” 
section on page 11-19.
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To display the Status settings, select Status in the left pane of the Preferences window.
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The Status settings contain the following fields and button:

Customizing the Color of Event Severities
MWTM enables you to customize the color of event severities.

To customize event severity colors, select Events in the left pane of the Preferences window, then click 
Change Color in the Event Colors section. MWTM displays the Select Event Color dialog.

The Select Event Color dialog is composed of the following sections:

• Swatches Panel (Recommended), page 11-18

• HSB Panel, page 11-18

Field or Button Description

Status Sort Order Indicates the status setting being defined. The default status sort order 
and colors are:

• None: Black

• Unknown: Red

• Unavailable: Red

• Inactive: Red

• Failed: Red

• Down: Red

• Blocked: Red

• Pending: Red

• Warning: Yellow

• Shutdown: Blue

• Discovering: Cyan

• Polling: Cyan

• Waiting: Gray

• Unmanaged: Gray

• Active: Green

Move Up Moves the selected status setting up in the Status Sort Order list.

Change Color Opens the Select Status Color dialog, which enables you to select a color 
for a status. For more details, see the “Customizing the Color of Chart 
Data Series” section on page 11-19.

Move Down Moves the selected status setting down in the Status Sort Order list.

Color Indicates the current color for the Series.

Change Color Opens the Select Series Color dialog, which enables you to select a color 
for a Series. For more details, see the “Customizing the Color of Status 
Settings” section on page 11-21.

Reset Order Restores the status settings to the default sort order.

Reset Colors Restores the status settings to the default colors.
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• RGB Panel, page 11-18

• Select Event Color Field and Buttons, page 11-18

Related Topics:

• Event Settings, page 11-10

Swatches Panel (Recommended)

The Swatches panel of the Select Event Color dialog enables you to select an event severity color from 
a set of color swatches. This is the recommended method for selecting an event severity color.

To display the Swatches panel, click the Swatches tab in the Select Event Color dialog.

To select an event severity color, select a swatch. The selected color is displayed in the Preview field. 
When you are satisfied with the color, click OK.

HSB Panel

The HSB panel of the Select Event Color dialog enables you to select an event severity color based on 
color hue, saturation, and brightness (HSB).

To display the HSB panel, click the HSB tab in the Select Event Color dialog.

To select an event severity color, use one of the following procedures:

• Select a color range on the vertical color bar, then select a specific color by moving the cursor around 
on the color square.

• Enter specific values in the hue (H), saturation (S), and brightness (B) fields.

The selected severity color is displayed in the Preview field. When you are satisfied with the color, click 
OK.

RGB Panel

The RGB panel of the Select Event Color dialog enables you to select an event severity color based on 
the red, green, and blue (RGB) content of the color.

To display the RGB panel, click the RGB tab in the Select Event Color dialog.

To select an event severity color, select values for the Red, Green, and Blue fields. The selected color 
is displayed in the Preview field. When you are satisfied with the color, click OK.

Select Event Color Field and Buttons

The Select Event Color dialog contains the following field and buttons:
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Customizing the Color of Chart Data Series
MWTM enables you to customize the color of series in real-time data charts.

To customize series colors, select Charts in the left pane of the Preferences window, then click Change 
Color in the Series Colors section. MWTM displays the Select Series Color dialog.

The Select Series Color dialog is composed of the following sections:

• Swatches Panel (Recommended), page 11-19

• HSB Panel, page 11-19

• RGB Panel, page 11-20

• Select Series Color Field and Buttons, page 11-20

Related Topics:

• Charts Settings, page 11-14

Swatches Panel (Recommended)

The Swatches panel of the Select Series Color dialog enables you to select a series color from a set of 
color swatches. This is the recommended method for selecting a series color.

To display the Swatches panel, click the Swatches tab in the Select Series Color dialog.

To select a series color, select a swatch. The selected color is displayed in the Preview field. When you 
are satisfied with the color, click OK.

HSB Panel

The HSB panel of the Select Series Color dialog enables you to select a series color based on color hue, 
saturation, and brightness (HSB).

To display the HSB panel, click the HSB tab in the Select Series Color dialog.

Field or Button Description

Preview Displays a preview of the current selected event severity color.

Whichever method you choose to select an event severity color, the selected 
color is displayed in the Preview field. When you are satisfied with the color, 
click OK.

OK Sets the event severity color as shown in the Preview field, and closes the 
Select Event Color dialog.

Cancel Closes the Select Event Color dialog without selecting an event severity color.

Reset Resets the event severity color to its initial setting.
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To select a series color, use one of the following procedures:

• Select a color range on the vertical color bar, then select a specific color by moving the cursor around 
on the color square.

• Enter specific values in the hue (H), saturation (S), and brightness (B) fields.

The selected color is displayed in the Preview field. When you are satisfied with the color, click OK.

RGB Panel

The RGB panel of the Select Series Color dialog enables you to select a series color based on the red, 
green, and blue (RGB) content of the color.

To display the RGB panel, click the RGB tab in the Select Series Color dialog.

To select a series color, select values for the Red, Green, and Blue fields. The selected color is displayed 
in the Preview field. When you are satisfied with the color, click OK.

Select Series Color Field and Buttons

The Select Series Color dialog contains the following field and buttons:

Field or Button Description

Preview Displays a preview of the current selected series color.

Whichever method you choose to select a series color, the selected color is 
displayed in the Preview field. When you are satisfied with the color, click 
OK.

OK Sets the series color as shown in the Preview field, and closes the Select Series 
Color dialog.

Cancel Closes the Select Series Color dialog without selecting a series color.

Reset Resets the series color to its initial setting.
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Customizing the Color of Status Settings
MWTM enables you to customize the color of status settings in the MWTM client.

To customize status setting colors, select Status in the left pane of the Preferences window, select a 
status setting, then click Change Color. MWTM displays the Select Status Color dialog.

The Select Status Color dialog is composed of the following sections:

• Swatches Panel (Recommended), page 11-21

• HSB Panel, page 11-21

• RGB Panel, page 11-22

• Select Status Color Field and Buttons, page 11-22

Related Topics:

• Status Settings, page 11-15

Swatches Panel (Recommended)

The Swatches panel of the Select Status Color dialog enables you to select a status color from a set of 
color swatches. This is the recommended method for selecting a status color.

To display the Swatches panel, click the Swatches tab in the Select Status Color dialog.

To select a status color, select a swatch. The selected color is displayed in the Preview field. When you 
are satisfied with the color, click OK.

HSB Panel

The HSB panel of the Select Status Color dialog enables you to select a status color based on color hue, 
saturation, and brightness (HSB).

To display the HSB panel, click the HSB tab in the Select Status Color dialog.
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To select a status color, use one of the following procedures:

• Select a color range on the vertical color bar, then select a specific color by moving the cursor around 
on the color square.

• Enter specific values in the hue (H), saturation (S), and brightness (B) fields.

The selected color is displayed in the Preview field. When you are satisfied with the color, click OK.

RGB Panel

The RGB panel of the Select Status Color dialog enables you to select a status color based on the red, 
green, and blue (RGB) content of the color.

To display the RGB panel, click the RGB tab in the Select Status Color dialog.

To select a status color, select values for the Red, Green, and Blue fields. The selected color is displayed 
in the Preview field. When you are satisfied with the color, click OK.

Select Status Color Field and Buttons

The Select Status Color dialog contains the following field and buttons:

Restoring Default Preference Settings
If you decide you do not like your modified preference settings, MWTM enables you to restore all 
preference settings to the original system default settings. To do so, display the Preferences window, as 
described in “Displaying the Preferences Window” section on page 11-4, then select the File > Load 
System Default Prefs menu option. MWTM restores the default settings.

Loading an Existing Preference Settings File
MWTM enables you to load an existing preference settings file. To do so, display the Preferences 
window, as described in “Displaying the Preferences Window” section on page 11-4, then select the File 
> Load menu option. MWTM displays the Load File Dialog: Preferences File List dialog.

The Load File Dialog: Preferences File List enables you to load a specific preferences file, change the 
list of preferences files, and select one preferences file to be loaded automatically when the MWTM 
client is started.

The Load File Dialog: Preferences File List contains the following fields and buttons:

Field or Button Description

Preview Displays a preview of the current selected status color.

Whichever method you choose to select a status color, the selected color is 
displayed in the Preview field. When you are satisfied with the color, click 
OK.

OK Sets the status color as shown in the Preview field, and closes the Select Status 
Color dialog.

Cancel Closes the Select Status Color dialog without selecting a status color.

Reset Resets the status color to its initial setting.
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Related Topics:

• Changing MWTM Client Preference Settings, page 11-2

Saving the Preference Settings File
MWTM enables you to save a specific preferences file, change the list of preferences files, and select 
one preferences file to be loaded automatically when the MWTM client is started.

When you are satisfied with any changes you have made to your preference settings, select File > Save 
As from the Preferences window. MWTM displays the Save File Dialog: Preferences File List dialog.

The Save File Dialog: Preferences File List contains the following fields and buttons:

Field or Button Description

Type Icon indicating whether the item in the table is a file or a 
folder.

Name Name of the preferences file or folder.

Last Modified Date and time the preferences file or folder was last modified.

Size (bytes) Size of the preferences file or folder, in bytes.

Number of Files
(displayed in bottom left corner)

Total number of preferences files and folders.

OK Loads the selected preferences file and closes the dialog.

To load a preference settings file, double-click it in the list, 
select it in the list and click OK, or enter the name of the file 
and click OK. MWTM loads the preference settings file, 
closes the Load File Dialog: Preferences File List dialog, and 
returns to the Preferences window.

To save any changes you made to the list of files, click OK. 
MWTM saves the changes, closes the Load File Dialog: 
Preferences File List dialog, and returns to the Preferences 
window.

Delete Deletes the selected file from the preferences file list.

Select a file and click Delete. MWTM issues an 
informational message containing the name and location of 
the deleted file.

Cancel Closes the dialog without loading a preference settings file or 
saving any changes to the preferences file list.

Help Displays online help for the dialog.

Field or Button Description

Type Icon indicating whether the item in the table is a file or a folder.

Name Name of the preferences file or folder.

Last Modified Date and time the preferences file or folder was last modified.

Size (bytes) Size of the preferences file or folder, in bytes.
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Related Topics:

• Changing MWTM Client Preference Settings, page 11-2

Changing MWTM System Poller Settings
MWTM provides three pollers for use in the MWTM client GUI and Web pages: a fast poller, a slow 
poller, and a status refresh poller. Each poller has default minimum, maximum, and default settings, but 
MWTM also enables you to change those settings. To do so, use the following procedure:

Step 1 Edit the System.properties file:

• If you installed MWTM in the default directory, /opt, then the location of the System.properties file 
is /opt/CSCOsgm/properties/System.properties.

• If you installed MWTM in a different directory, then the System.properties file is located in that 
directory.

Step 2 To change fast poller settings, change one or more of the following lines in the file:

Filename Name by which you want to save the preferences file.

To save the preference settings file with a new name, use one of 
the following procedures:

• To save the file with a completely new name, enter the new 
name and click OK.

• To save the file with an existing name, overwriting an old 
preference settings file, select the name in the list and click 
OK.

MWTM saves the preference settings file with the new name, 
closes the Save File Dialog: Preferences File List dialog, and 
returns to the Preferences window.

If you create a new preferences file name, you can use any letters, 
numbers, or characters in the name that are allowed by your 
operating system. However, if you include any spaces in the new 
name, MWTM converts those spaces to dashes. For example, 
MWTM saves file “a b c” as “a-b-c”.

Number of Files
(displayed in bottom left corner)

Total number of preferences files and folders.

OK Saves any changes you made to your preferences, or to the list of 
preference files, and closes the dialog.

Delete Deletes the selected file from the preferences file list. MWTM 
issues an informational message containing the name and location 
of the deleted file.

Cancel Closes the dialog without saving the preference settings file or 
any changes to the preference settings file list.

Help Displays online help for the dialog.

Field or Button Description
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# Fast poller default polling interval in seconds

FAST_POLLER_DEFAULT = 15

# Fast poller minimum polling interval in seconds

FAST_POLLER_MIN = 15

# Fast poller maximum polling interval in seconds

FAST_POLLER_MAX = 60

For example, to change the fast poller default to 30 seconds, change the DEFAULT line to:

FAST_POLLER_DEFAULT = 30
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Step 3 To change slow poller settings, change one or more of the following lines in the file:

# Slow poller default polling interval in seconds

SLOW_POLLER_DEFAULT = 60

# Slow poller minimum polling interval in seconds

SLOW_POLLER_MIN = 60

# Slow poller maximum polling interval in seconds

SLOW_POLLER_MAX = 300

For example, to change the slow poller default to 180 seconds, change the DEFAULT line to:

SLOW_POLLER_DEFAULT = 180

Step 4 To change status refresh poller settings, change one or more of the following lines in the file:

# Status refresh default interval in seconds

STATE_REFRESH_DEFAULT = 180

# Status refresh minimum interval in seconds

STATE_REFRESH_MIN = 180

# Status refresh maximum interval in seconds

STATE_REFRESH_MAX = 900

For example, to change the status refresh poller default to 300 seconds, change the DEFAULT line to:

STATE_REFRESH_DEFAULT = 300

Step 5 Save your changes and restart the MWTM server.

Any changes you make take effect when you restart the MWTM server, and are reflected throughout the 
MWTM client GUI and Web pages at that time.

For each of these pollers, keep the following considerations in mind:

• If you set the minimum interval for a poller to less than 0 seconds, MWTM overrides that setting 
and resets the minimum interval to 0 seconds.

• If you set the maximum interval for a poller to less than the minimum interval, MWTM overrides 
that setting and resets the maximum interval to be equal to the minimum interval.

• If you set the default interval for a poller to less than the minimum interval, MWTM overrides that 
setting and resets the default interval to be equal to the minimum interval.

• If you set the default interval for a poller to more than the maximum interval, MWTM overrides that 
setting and resets the default interval to be equal to the maximum interval.
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Changing the Message Display
The following sections provide information about changing the way MWTM displays and stores 
messages:

• Changing the Location of MWTM Message Log Files, page 11-27

• Changing the Size of the MWTM Message Log File, page 11-27

• Changing the Time Mode for Dates in Log Files, page 11-27

• Changing the Age of the MWTM Message Log Files, page 11-27

Changing the Location of MWTM Message Log Files
By default, all MWTM system message log files are located on the MWTM server at 
/opt/CSCOsgm/logs. To change the location of the system message log directory, use the mwtm 
msglogdir command. See the “mwtm msglogdir” section on page C-32 for more information.

Changing the Size of the MWTM Message Log File
To change the size of the message log file, use the mwtm msglogsize command. See the “mwtm 
msglogsize” section on page C-32 for more information.

Changing the Time Mode for Dates in Log Files
To change the time mode for dates in log files, use the mwtm logtimemode command. See the “mwtm 
logtimemode” section on page C-27 for more information.

Changing the Age of the MWTM Message Log Files
To change the number of days MWTM archives system message log files before deleting them from the 
MWTM server, use the mwtm msglogage command. See the “mwtm msglogage” section on page C-31 
for more information.

Enabling SNMP Traps (Server Only)
By default, MWTM cannot receive SNMP traps. To use SNMP traps with MWTM, you must first 
configure MWTM to receive traps.

Related Topics:

• Integrating MWTM with Other Products, page 3-35

• Viewing Network Status Information for MWTM, page 13-3

To view the current trap reception configuration for MWTM, use the following procedure:
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Step 1 Log in as the root user, as described in the “Becoming the Root User (Server Only)” section on page 3-3, 
or as a super user, as described in the “Specifying a Super User (Server Only)” section on page 10-19.

Step 2 Enter the following commands:

# cd /opt/CSCOsgm/bin

# ./mwtm trapstatus

MWTM displays the current trap reception configuration for MWTM, including:

• SNMP trap integration type:

– native—MWTM receives traps natively on a UDP port.

– hpov—MWTM receives traps using HP OpenView.

• For native, MWTM also displays the UDP port number on which MWTM receives traps natively.

• For hpov, MWTM also displays the location of the HP OpenView home directory.

• Whether the trap listener is enabled or not.

To configure MWTM to receive traps, using the following procedure:

Step 1 Log in as the root user, as described in the “Becoming the Root User (Server Only)” section on page 3-3, 
or as a super user, as described in the “Specifying a Super User (Server Only)” section on page 10-19.

Step 2 Enter the following commands:

# cd /opt/CSCOsgm/bin

# ./mwtm trapsetup

MWTM displays the following message and prompt:

The MWTM server must also be stopped to perform this operation.

Do you wish to continue? [n]

Step 3 Type y and press Enter. MWTM stops the MWTM server and displays the following prompt:

Would you like to configure MWTM to receive SNMP traps? [yes]

Step 4 Press Enter. MWTM displays the following message and prompt:

MWTM can receive traps natively on a UDP port or receive traps via integration with HP 
OpenView.

Enter SNMP trap integration type: native or hpov? [native]

• If you want MWTM to receive traps natively, press Enter. The MWTM installation program 
displays the following messages and prompt:

MWTM can receive traps natively on the standard UDP port number 162 or on any other UDP 
port chosen. If another application is already bound to the SNMP standard trap reception 
port of 162, an alternate port number for MWTM must be specified.
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UDP port number 44750 is the default alternate port.

Enter trap port number? [162]

By default, network elements send traps to port 162. To accept the default value, press Enter.

If your network elements have been configured to send traps to a different port, type that port 
number and press Enter.

By default, MWTM listens for traps from trap multiplexing devices and NMS applications on port 
44750. If you want MWTM to monitor that port, and port 162 is not available on the MWTM server 
device, type 44750 and press Enter.

If trap multiplexing devices and NMS applications in your network have been configured to send 
traps to a different port, type that port number and press Enter.

If you are a super user, you must specify a port number that is greater than 1024, then press Enter.

Do not enter a non-numeric port number. If you do, you are prompted to enter a numeric port 
number.

When you select an SNMP trap port number for the MWTM server, make sure your routers use the 
same SNMP trap port number. See the description of the snmp-server host command in the 
“RAN-O Requirements” section of the Cisco Mobile Wireless Transport Manager Installation 
Guide for more information.

• If you want MWTM to receive traps using HP OpenView, type hpov and press Enter. The MWTM 
installation program displays the following prompt:

Please enter location of HP OpenView home directory: [/opt/OV]

To accept the default value, press Enter; or type a different location and press Enter.

Step 5 MWTM confirms your choices and restarts the MWTM server.

You can change all aspects of MWTM event processing, including the size of the MWTM event database, 
the maximum length of time MWTM is to retain events, and the default severity and color associated 
with each type of event. If a new trap becomes available that is of interest to MWTM, you can add it to 
the MWTM event database, enabling MWTM to recognize and process the new trap. For more 
information about changing MWTM event processing, see the “Changing the Way MWTM Processes 
Events” section on page 5-17.

Limiting Traps by IP Address (Server Only)
By default, when you first install MWTM, all IP addresses are allowed to send traps to the MWTM 
server. However, MWTM enables you to limit the IP addresses that can send traps to the server by 
creating and maintaining the trapaccess.conf file.

You can create the trapaccess.conf file and populate it with a list of IP addresses that can send traps to 
the MWTM server. MWTM receives traps from only those IP addresses, plus the local host. If the file 
exists but is empty, MWTM receives traps only from the local host. (MWTM always receives traps from 
the local host.)

When you first install MWTM, the trapaccess.conf file does not exist and MWTM allows all IP 
addresses to send traps to the MWTM server.
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To create the trapaccess.conf file and work with the list of allowed IP addresses, use the following 
procedure:

Step 1 Log in as the root user, as described in the “Becoming the Root User (Server Only)” section on page 3-3, 
or as a super user, as described in the “Specifying a Super User (Server Only)” section on page 10-19.

Step 2 Enter the following command:

# cd /opt/CSCOsgm/bin

Step 3 Create the trapaccess.conf file:

• To create the trapaccess.conf file and add a client IP address to the list, enter the following 
command:

# ./mwtm trapaccess add

Enter address to add: 1.2.3.4
IP Address 1.2.3.4 added.
MWTM server must be restarted for changes to take effect.
Use the following command to restart the server:
   mwtm restart
#

• To create the trapaccess.conf file and open the file to edit it directly, enter the following command:

# ./mwtm trapaccess edit

The default directory for the file is located in the MWTM installation directory:

• If you installed MWTM in the default directory, /opt, then the default directory is 
/opt/CSCOsgm/etc.

• If you installed MWTM in a different directory, then the default directory is located in that directory.

In the trapaccess.conf file, begin all comment lines with a pound sign (#).

All other lines in the file are MWTM client IP addresses, with one address per line.

Wildcards (*) are allowed, as are ranges (for example, 1-100). For example, the address *.*.*.* allows 
all clients to send traps to the MWTM server.

After you create the trapaccess.conf file, you can use the full set of mwtm trapaccess keywords to work 
with the file. See the “mwtm trapaccess” section on page C-68 for more details.

Any changes you make to the trapaccess.conf file take effect when you restart the MWTM server.

Setting the DISPLAY Variable (Client Only)
The DISPLAY variable is set as part of your login environment on Solaris/Linux. However, if you Telnet 
into a remote workstation, you must set the DISPLAY variable to local display. To do so, enter the 
following command:

# setenv DISPLAY local_ws:0.0

where local_ws is your local workstation.
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If your shell does not support the setenv command, enter the following command:

# export DISPLAY=local_ws:0.0

Backing Up or Restoring MWTM Files (Server Only)
MWTM automatically backs up all MWTM data files to the MWTM installation directory at 1:30 AM 
each night.

To change the time at which MWTM automatically backs up files, log in as the root user and change the 
root crontab file.

To manually back up the MWTM data files at any time, log in as the root user, as described in the 
“Becoming the Root User (Server Only)” section on page 3-3, and enter the following commands:

# cd /opt/CSCOsgm/bin

# ./mwtm backup

MWTM backs up the data files in the installation directory.

If you installed MWTM in the default directory, /opt, then the default backup directory is also /opt. If 
you installed MWTM in a different directory, then the default backup directory is that directory.

To change the directory in which MWTM stores its nightly backup files, log in as the root user, as 
described in the “Becoming the Root User (Server Only)” section on page 3-3, or as a super user, as 
described in the “Specifying a Super User (Server Only)” section on page 10-19, then enter the following 
commands:

# cd /opt/CSCOsgm/bin

# ./mwtm backupdir directory

where directory is the new backup directory. If the new directory does not exist, MWTM does not change 
the directory, and issues an appropriate message.

To restore the MWTM data files from the previous night’s backup, log in as the root user, as described 
in the “Becoming the Root User (Server Only)” section on page 3-3, and enter the following commands:

# cd /opt/CSCOsgm/bin

# ./mwtm restore

MWTM restores the data files.

Warning Do not interrupt this command. Doing so can corrupt your MWTM data files.

The mwtm restore command provides optional keywords that enable you to restore only selected 
MWTM data files, such as log files, report files, or security files. For more information, see the “mwtm 
restore” section on page C-41.
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Removing MWTM Data from the MWTM Server
There might be times when you want to remove all MWTM data from the MWTM server, without 
uninstalling the product. There are two ways to do this, both of which restore the MWTM server to a 
“clean” state, such as would exist after a new installation of MWTM.

To remove all MWTM data from the MWTM server, excluding message log files, backup files, and 
report files, log in as the root user, as described in the “Becoming the Root User (Server Only)” section 
on page 3-3, then enter the following commands:

# cd /opt/CSCOsgm/bin

# ./mwtm clean

Data removed includes all MWTM data, notes, preferences, security settings, seed files, event filters, 
report control files, and views, as well as any user-created files stored in MWTM directories.

To remove all MWTM data from the MWTM server, including all view files, notes associated with 
objects, and event filters and preferences, excluding message log files, backup files, report files, 
configuration settings, and security settings, log in as the root user, as described in the “Becoming the 
Root User (Server Only)” section on page 3-3, then enter the following commands:

# cd /opt/CSCOsgm/bin

# ./mwtm cleandb

This command restores the MWTM server to a “clean” state, such as would exist after a new installation 
of MWTM, except for the presence of the retained files. Data removed includes all MWTM data, notes, 
preferences, route files, and views, as well as any user-created files stored in MWTM directories.
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To remove all MWTM data from the MWTM server, including message log files, backup files, and 
report files, log in as the root user, as described in the “Becoming the Root User (Server Only)” section 
on page 3-3, then enter the following commands:

# cd /opt/CSCOsgm/bin

# ./mwtm cleanall

Data removed includes all MWTM data, notes, preferences, security settings, seed files, event filters, 
report control files, views, message log files, backup files, and report files, as well as any user-created 
files stored in MWTM directories.

Configuring a Backup MWTM Server (Server Only)
MWTM enables you to configure a second MWTM server as a backup for the primary MWTM server. 
For best results, Cisco recommends that you configure the primary server and the backup server as 
backups for each other.

To configure a backup MWTM server, use the following procedure:

Step 1 Log in as the root user, as described in the “Becoming the Root User (Server Only)” section on page 3-3, 
or as a super user, as described in the “Specifying a Super User (Server Only)” section on page 10-19.

Step 2 Enter the following commands:

# cd /opt/CSCOsgm/bin

# ./mwtm secondaryserver hostname naming-port

where:

• hostname is the optional name of the host on which the backup MWTM server is installed.

• naming-port is the optional MWTM Naming Server port number for the backup MWTM server. The 
default port number is 44742.

Note If you use the mwtm secondaryserver command to configure a backup MWTM server, but 
the primary MWTM server fails before you launch the MWTM client, then the MWTM client 
has no knowledge of the backup server.

Step 3 (Optional) To list the backup MWTM server that has been configured for this primary MWTM server, 
enter the following commands:

# cd /opt/CSCOsgm/bin

# ./mwtm secondaryserver list
11-33
Cisco Mobile Wireless Transport Manager User Guide 5.0

OL-7637-02



 

Chapter 11      Configuring MWTM for Your Network
  Configuring MWTM with IOS Server Load Balancing
Configuring MWTM with IOS Server Load Balancing
If a network failure causes MWTM to fail, you can no longer monitor your network. You can solve this 
potential problem by configuring a backup MWTM server, as detailed in the “Configuring a Backup 
MWTM Server (Server Only)” section on page 11-33. However, this solution requires a connection to 
the backup MWTM server, which might not mirror exactly the primary MWTM server.

A better solution is to use IOS Server Load Balancing (IOS SLB), which provides transparent failover 
of the MWTM client connection.

Use the following procedure to configure MWTM with IOS SLB:

Step 1 Make sure you have the following required hardware and software:

• Solaris/Linux server with at least two network interface cards (NICs)

• Cisco 7204VXR or 7206VXR series router

• IOS SLB release 12.1(11b)E or later

• MWTM release 5.0 or later

Step 2 Configure the Solaris/Linux server with at least two active NICs.
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Step 3 Configure a routing protocol on the Solaris/Linux server, such that if one network interface fails, the 
other interfaces can still contact the monitored networks and the MWTM client:

• Run in.routed on the Solaris/Linux server, with two RIP-based routers on two separate networks 
providing routing tables for the server. Refer to the in.routed man page for more information on this 
configuration.

• Use the GateD routing software developed by NextHop Technologies. Refer to the following URL 
for more information:

http://www.gated.org

Step 4 Configure the Cisco 7204VXR or 7206VXR series router, with the Solaris/Linux server network 
interfaces configured as real servers in the server farm. Refer to the IOS SLB feature module for more 
information on configuring the IOS SLB router.

Step 5 Configure a virtual interface, lo0:1 with the Internet address that matches the virtual IP address 
configured on the IOS SLB router:

ifconfig lo0:1 addif ip-address

Step 6 Install MWTM.

Step 7 Edit the /opt/CSCOsgm/properties/System.properties file, and replace the SERVER NAME variable 
with the DNS entry that matches the virtual IP address configured on the IOS SLB router. Save your 
changes and restart the MWTM server.

Step 8 Configure your MWTM clients to match the same DNS entry.

Step 9 Your configuration is complete.

Keep in mind the following considerations:

• Failover of the MWTM client is transparent to the user. There are no additional changes needed at 
that end.

• A failure of either interface, or of the surrounding networks, might cause the MWTM client to hang 
for a short period, depending on the convergence of the routing protocol used by the MWTM server. 
For example, with RIP, the MWTM client might hang for up to two minutes while RIP converges 
after a network failure. Faster protocols might result in shorter MWTM client hang times.

Configuring an MWTM Client Connection Timer
MWTM enables you to specify how long an MWTM client is to wait for the MWTM server before 
exiting.

To configure an MWTM client connection timer, use the following procedure:

Step 1 Log in as the root user, as described in the “Becoming the Root User (Server Only)” section on page 3-3, 
or as a super user, as described in the “Specifying a Super User (Server Only)” section on page 10-19.

Step 2 Enter the following commands:

# cd /opt/CSCOsgm/bin

# ./mwtm cliconntimer number-of-seconds
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where number-of-seconds is the time the MWTM client is to wait for a message from the MWTM server 
before exiting. The valid range is 10 seconds to an unlimited number of seconds. The default value is 
60 seconds.

If the timer expires, the client pings the server and takes the following action:

• If the server responds to the ping, the client reconnects to the server.

• If the server does not respond to the ping, but there is a backup server configured, the client connects 
to the backup server.

• If the server does not respond to the ping, and there is no backup server configured, the client stops.

The timer takes effect when you restart the MWTM server.

Step 3 (Optional) To restore the default timeout of 60 seconds, enter the following command:

# ./mwtm cliconntimer clear

The timer is reset to 60 seconds when you restart the MWTM server.

Telnetting to a Router
MWTM enables you to link to a router using Telnet.

To Telnet to a router, right-click a node in a window, then select Router > Telnet to from the right-click 
menu.

Note If your client workstation does not have network access to the IP address of the router (that is, if the 
router is behind a firewall or NAT device), you might be unable to Telnet to the router.

To specify the path to the Telnet application to use for Telnet sessions on the MWTM client, as well as 
any special parameters to pass to the Telnet application, use the mwtm telnetpath command.

To manage a Telnet proxy, use the mwtm tnproxy command.

See the “MWTM Command Reference” section on page C-1 for more information on the use of these 
commands.
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